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Java EE Servlets y JSPs

m Servlet

m Clase Java que implementa un modelo de programacion peticion-
respuesta

» Puede usarse para procesar cualquier tipo de peticion
= Clase GenericServlet

» Definido en el paquete javax.servlet

- Hay subclases especificas para HTTP: paquete javax.servilet.http
« Clase HttpServlet

m Tiene un ciclo de vida concreto controlado por el contenedor en el que
se despliega

m Cada servlet se ejecuta como un thread independiente

m JSP (JavaServer Page)
m Fichero con codigo (X)HTML que incluye scripts codificados en Java
= Se compila y se convierte en un servlet

m Utiliza etiquetas especializadas (Custom Tags) que amplian la sintaxis
de HTML
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Ciclo de vida de un servlet

m Lo controla el contenedor en el que se ha desplegado

m Al llegar una peticién correspondiente a un servlet, el contenedor
1. Comprueba si existe una instancia del serviet
« Si no existe
e Carga la clase del serviet
< Crea una instancia del servlet
= Inicializa la instancia del servlet llamando al método init()
2. Se invoca al método de servicio, pasandole objetos de tipo request
y response
e El servlet usa estos objetos para inspeccionar la peticiéon y generar la
respuesta

3. Si hay que eliminar el servlet, el contenedor llama al método destroy()
del servlet

Juan Pavon - UCM 2012-13 Servlets

Servlet

m Cualquier clase que implemente la interfaz
Javax.servilet.Servlet
m Métodos para gestionar el ciclo de vida del servlet

m También suele ser necesaria la interfaz
Javax.servlet.ServletConfig

m Tiene los parametros de arranque e inicializacion para el servlet que le
pasa el contenedor

= Normalmente los servlets se implementan a partir de una de las
dos subclases siguientes que implementan ambas interfaces:
m javax.servlet.GenericServlet
« Clase que define un servlet independiente del protocolo
m javax.servilet.http.HttpServlet

e Para servlets en aplicaciones web, que procesan las peticiones con el
protocolo HTTP
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Metodos de la interfaz javax.servlet.Servlet

m init(ServletConfig config)
m Al arrancar un servlet, solo se ejecuta una vez
m Inicializa atributos y recursos del servlet

m getServiletConfig()

m Devuelve el objeto ServletConfig que contiene parametros de arranque e
inicializacion para el servlet que le pasa el contenedor

m service(ServletRequest request, ServiletResponse response)
m Cada vez que se invoca un servicio al servlet

m Dependiendo del tipo de servicio, invoca el método correspondiente al
servicio solicitado

= Normalmente no se reescribe este método, solo los correspondientes a
los servicios especificos

m Pueden invocarse concurrentemente los métodos de servicio, por ello
deben ser thread safe

m destroy()
m Al eliminar un servlet, solo se ejecuta una vez
m Tiene que ser thread-safe porque puede haber otros threads en
ejecucion

Juan Pavon - UCM 2012-13 Servlets

Metodos de la clase javax.serviet.HTTPServlet

m El método service trata las siguientes peticiones:
m DELETE, GET, HEAD, OPTIONS, POST, PUT, y TRACE
m Invoca el método correspondiente doXXX

m Los mas usados:
m doGet(HttpServiletRequest request, HttpServietResponse response)
m doPost(HttpServletRequest request, HttpServietResponse response)

m Estos dos métodos son los que normalmente se tienen que
reescribir
m El objeto request tiene informacién enviada en la peticion
m El objeto response permite crear la respuesta

= setContentType() — permite indicar el tipo MIME de lo que se va a
generar (por ejemplo, "text/html™)

e getWriter() — devuelve el PrintWriter donde escribir lo que se genere
m Pueden producir dos excepciones:

= IOException, porque usan operaciones de E/S

» ServletException, cualquier otra excepcion que se quiera
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Creacion de servlets con eclipse

m  Crear un proyecto Web dindmica
m File > New - Project > Web > Dynamic Web Project
e Nombre, p.ej. PrimerosServlets
e Target runtime: Apache Tomcat v7.0

m En src, crear un paquete
e Nombre, p.ej. es.ucm.prueba

m Dentro del paquete, crear un servilet con el asistente de creacion
m File > New - Other y seleccionar servlet en Web
e Nombre, p.ej. Saludo
= En el método doGet() incluir el c6digo que aparece a continuacion
- Habra que importar la clase java.io.PrintWriter
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Ejemplo de serviet elemental

package es.ucm.prueba;

import java.io.IOException;
import java.io.PrintWriter;

import javax.servlet.ServletException;

import javax.servlet.annotation.WebServlet;
import javax.servlet.http.HttpServlet;

import javax.servlet.http.HttpServletRequest;
import javax.servlet.http.HttpServletResponse;

URL relativo a la webapp }

@WebServlet("/Saludo")
public class Saludo extends HttpServlet {
private static final long serialVersionUID = 1L;

Método para tratar la

e recepcion de un HTTP GET
* HttpServlet#doGet (Htt
*/

protected void doGet(HttpServletRequest request, HttpServletResponse response)

throws ServletException, IOException { .
. . . . Salida generada para
PrintWriter out = response.getWriter(); .
out.println("iBienvenido al mundo de los servlets!"); enviar al navegador

} Generacion de texto }

quest request, HttpServletResponse response)




Creacion de servlets con eclipse

m Ejecutar
= Run As...2Run On Server
e La primera vez aparece una ventana para indicar en qué servidor se
quiere ejecutar
* Elegir Tomcat v7.0 Server at localhost

< En Add and remove, si no esta en la lista de Configured, seleccionar el
proyecto en Available y pulsar el botén Add>

m Solicitar restart server
e Permite que el servidor arranque con la nueva configuraciéon

m Aparece una pestafa en el area de trabajo con el resultado de ejecutar
el servlet en un navegador

= Si el URL que aparece es http://localhost:8080/PrimerosServiets/
saldra el error 404 (recurso no disponible)

e Para que se vea la pagina, incluir en la URL el nombre del serviet
« http://localhost:8080/PrimerosServlets/Saludo
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Primeros servlets con eclipse y tomcat

i@} Java EE - http://localhost:8080/PrimerosServlets/ - Eclipse

File Edit Mawvigate Search Project Bun  Window Help
o OGN

I Project Explorer 53 | = Q:;;l ¥ =8 (@ http://localhost:8080,PrimerosServiets/Saludo &3

| AR R SRl Ne=R CR SR° B

4 = Servers it S [E . http//localhost:8080/PrimerosServiets/Saludo
» [ Teomcat v7.0 Server at localhost-config

4 g PrimerosServiets
» A JAK-WS Web Services
- 'ag Deployment Descriptor: PrimerosServie

jBienvenido al mundo de los serviets!

4 B Java Resources
4 [ src
4 8 es.ucm.prueha
- [J] Salude.java
. =4, Libraries
- B JavaScript Resources
¢ = build
4 = WebContent
+ = META-INF
s = WEB-INF
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Ejercicios

m  Afadir un fichero index.html en el proyecto en WebContent
= New > HTML file

m Ahora si que se podra ver la pagina
http://localhost:8080/PrimerosServiets/

m Crea otro servlet SaludoHTML, que genere cddigo HTML correcto
m Para indicar el tipo de documento
* response.setContentType("text/html™);
m Generar el texto HTML correspondiente

m En el fichero index.html afiade enlaces para poder invocar a los
dos servlets

m  Afadir un atributo int contador que permite al servlet llevar una
cuenta de las veces gque se invoca
= Se define como un atributo normal en la clase
= Se puede visualizar en la pagina
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Interaccion con formularios

http://localhost:8080/PrimerosServlets/hola.html hola.html

\ <p>Por favor, indique su nombre:</p>
<form method="get"

action="/PrimerosServlets/ProcesaForm">
<p>Nombre:
<input type="text" name="cliente" />

@ Formulario de saludo 53 <input type="submit" value="Enviar"/></p>
</form>
o W qg"' http://localhost:8080/PrimerosServiets/hola.html
Por favor, indique su nombre:
Nombre: Juan| Enviar \N ProcesaForm J ava
out.println("<!DOCTYPE html>\n" +
//...
"<h1l>Hola
:4;————"’ "t+request.getParameter("cliente")+"</h1>\n" +
(@ Fermulario de saludo 2 /...
=] [} Q§' http://localhost:8080/PrimerosServiets/ProcesaForm?cliente=Juan

Hola Juan
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Formularios

m La pagina HTML con los formularios va en la carpeta WebContent

m En el ejemplo, el fichero hola.html ira en WebContent del proyecto
PrimerosServlets

e El URL para acceder sera
http://localhost:8080/PrimerosServiets/hola.html

m El fuente del servlet se creara en src, dentro del paquete
correspondiente
s El servlet (compilado) ird en WEB_INF/classes
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Ejemplo de proceso de formulario

package es.ucm.prueba;

import java.io.*;

import javax.servlet.ServletException;
import javax.servlet.annotation.WebServlet;
import javax.servlet.http.*;

@WwebServlet("/ProcesaForm")
public class ProcesaForm extends HttpServlet {
private static final long serialVersionUID = 1L;

protected void doGet(HttpServletRequest request, HttpServletResponse response)
throws ServletException, IOException {

response.setContentType("text/html");

PrintWriter out = response.getWriter();

out.println ("<!DOCTYPE html>\n" + "<html>\n" +
"<head><title>Formulario de saludo</title></head>\n" +
"<body>\n" +
"<hl>Hola "+request.getParameter("cliente”)+"</h1>\n" +
"</body></html>");




Parametros de la peticion

m Los parametros que llegan con GET y POST los tiene el objeto
request y se pueden acceder con varios metodos:
= public Enumeration getParameterNames()
e Devuelve un Enumeration con los nombres de los parametros
= Si no los hubiera, el Enumeration estar& vacio
= public String getParameter(String name)
e Valor del parametro como un String
e null si no existiera ese parametro
= public String[] getParameterValues(name)
< Si un parametro puede tener varios valores mejor usar este método

m Un objeto Enumeration se usa como un lterador:

Enumeration e = request.getParameterNames();
while (e.hasMoreElements()) {
out.println(e.nextElement());

}
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Parametros de la peticion

m Para pasar los valores de los parametros de String al valor del
tipo correspondiente
= int n = new Integer(parametro).intValue();
= double d = new Double(parametro).doubleValue();
= byte b = new Byte(parametro).byteValue();

e Estas operaciones se tienen que hacer en un try para poder capturar
la excepciéon NumberFormatException

= boolean p = new Boolean(param).booleanValue();
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Parametros de la peticion

m Hay que comprobar siempre que los parametros recibidos son
correctos
m Si falta un campo en el formulario, getParameter() devuelve null
= Hay que comprobar que el string tiene el formato correcto
= Por ejemplo, que al convertir a un nidmero no se genera la excepcion
NumberFormatException
Cuando no se ha rellenado el campo correspondiente se recibe el string
vacio
Conviene eliminar los espacios en blanco con el método trim()

String parametro = request.getParameter("nombre");
if ((parametro == null) || (parametro.trim().equals(""))) {
// Tratamiento de parametro errodneo

else {
// Tratamiento normal con el parametro
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Parametros de la peticion

m Lo habitual cuando hay errores en los formularios es volver a
mostrarlos de nuevo

= Mostrando los valores correctos en sus campos (el usuario no tiene
que volver a introducirlos)

= Marcar los campos que no se han rellenado

= Si se han rellenado mal, afiadir un comentario para indicar al usuario
qué tiene que hacer

m Con JSF, o frameworks como Struts, es mas facil la gestion de
formularios

m También es conveniente usar JavaScript para hacer una primera
comprobacion de los campos del formulario
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Cabecera de la peticion

m Los parametros de la cabecera de un mensaje HTTP se pueden
obtener con los siguientes métodos
m  String getHeader(String nombre)

e Devuelve el valor de la cabecera indicada, null si no hay una
cabecera con ese nombre

= Enumeration<String> getHeaders(String nombre)

e Algunas cabeceras, como Accept-Language, pueden tener una lista
de valores

Enumeration<String> getHeaderNames()

= Los nombres de todas las cabeceras presentes
String getMethod()

e Indica el método HTTP: GET, POST, o PUT

String getQueryString()

* La query string que hay en el URL, o null si no hay
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Ejercicios

m Crear un servlet gue muestre en una pagina el mensaje GET o
POST que haya recibido, con todas las cabeceras y los
parametros

m El codigo del doGet y doPost seréd igual, por lo cual se podria poner el
codigo en el doGet y en el doPost invocar al doGet:

public void doPost(HttpServletRequest request,
HttpServletResponse response) {
doGet(request, response);

J| Cabecera,java Formulario de saludo &2 = 8
i)
=) B | hitp://localhostB080/PrimerosServlets/Cabeceratusuario=Juan - B

Mensaje recibido

GET

accept: application/x-ms-application, image/jpeg, application/xaml+xml, image/gif, image/pjpeg. application/x-ms-xbap,
accept-language: es-ES

cache-control: no-cache

user-agent: Mozilla/5.0 (compatible; MSIE 9.0; Windows NT 6.1; Win64: x64; Trident/5.0; MATM)

ua-cpu: AMD64

accept-encoding: gzip, deflate

host: localhost:8080

connection: Keep-Alive

>k

usuario=Juan
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Cookies

m Funcionamiento de los Cookies

(1) peticion

HTTP

crea cookie,

/I
\ (2) respuesta HTTP | |navegador

\

ﬂk

servidor

(3) peticién HTTP
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Programacion de cookies con Java

m Creacion y envio de un cookie
m Por un servlet como respuesta a una peticion HTTP

m clase javax.servlet.http.Cookie

// 1. crea el cookie
Cookie cookie = new Cookie("nombre", "valor");

m El cookie se envia como parte de una respuesta HTTP

// 2. envia el Cookie en un HTTPServletResponse

public void doGet (HttpServletRequest, request,
HttpServletResponse response) throws IOException

{

response.addCookie(cookie);
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Programacion de cookies con Java

m Envio de un identificador Unico
m La clase java.rmi.server.UID permite crear identificadores que son
unicos dentro de la maquina en gue se generan
String uid = new java.rmi.server.UID().toString();

m Para enviarlo por HTTP hace falta codificarlo con el método enconde()
de java.net.URLEncoder, que convierte el string al formato MIME
denominado x-www-form-urlencoded
e 'a'-"z",'A'"-'Z', y '0" - '9" no se modifican.

e El caracter de espacio se transforma en '+'.
« Los demas caracteres se convierten en string de 3-caracteres "%xy",

donde xy es la representacion hexadecimal con dos digitos de los 8-
bits del caréacter

Cookie cookie = new Cookie("uid",
java.net.URLEncoder.encode(uid));
/] ...

response.addCookie (cookie));
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Programacion de cookies con Java

m Recepcion de cookies
m Con una respuesta HTTP se pueden recibir varios cookies asociados

public void doGet (HttpServletRequest request,
HttpServletResponse response) throws IOException

Cookie[] cookies = request.getCookies();
if ( cookies != null )
for (int i=0; i<cookies.length; i++) {
Cookie unCookie = cookies[i];
System.out.println(" nombre: " + unCookie.getName()

+ ", valor: + unCookie.getValue());
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Programacion de cookies con Java

m Configuracion de cookies
m La clase Cookie ofrece operaciones para configurar los atributos de
cada cookie
« Tiempo de expiracion
cookie.setMaxAge (numero_segundos);
// si @, entonces el cookie expira inmediatamente
// si negativo, el cookie expira al apagar el navegador

< Comentario
cookie.setComment ("comentario");
Sring txt=cookie.getComment();

= Dominio
cookie.setDomain ("patron_de_dominio");

< Valor (para modificar el que se le dio al crearlo)

cookie.setValue ("nuevovalor");
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Gestion de sesiones con servlets

m Las sesiones se representan con objetos de la clase
javax.servlet.http.HttpSession
m Basado en el mecanismo de cookies
m Permite mantener el estado del cliente

m La informacién sobre la sesién se mantiene automaticamente de una
peticion a otra, incluso en el caso de rearranque del servidor

m Crear una sesion:
HttpSession sesion = request.getSession();
m Devuelve la sesién asociada con la peticion
= Si no existiera, la crea

m  Crear o modificar atributos de la sesion:
sesion.setAttribute(nombre, valor);

m Consulta de valores de atributos de la sesion:
Object obj = sesion.getAttribute(nombre);

Consulta de todos los nombres de atributos de la sesién:
Enumeration<String> e = sesion.getAttributeNames()
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Gestion de sesiones con servlets

m Tras un periodo de inactividad las sesiones se cierran

m Puede configurarse el tiempo, en segundos, que el contenedor del
servlet mantendrda la sesion abierta entre accesos del cliente:

* void setMaxlInactivelnterval(int interval)
- Si interval es 0 o negativo, el contenedor no cerrard la sesion

* int getMaxInactivelnterval()

m Otros métodos para trabajar con sesiones:
m long getCreationTime()
= long getLastAccessedTime()
e Ambos en numero de milisegundos desde 1/1/1970 GMT
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Ejercicios de sesidn con servlets

m Prueba a contar el niUmero de accesos de un cliente a una pagina
durante una sesién
m La pagina tendra un botén para iniciar la sesion y otro para cerrarla

= También visualizar4 en cada momento el nUmero de accesos que se
han producido a la pagina durante la sesion

= Adicionalmente podra mostrar informacion de cuanto tiempo ha
transcurrido desde el Ultimo acceso

m Crea una secuencia de paginas que soliciten informacién sobre un
usuario

m En la primera pagina su nombre, en la segunda su numero de teléfono
y en la tercera su email

m En la cuarta se mostraran los datos recibidos

m En ambos ejercicios, prueba a acceder a la vez desde dos
navegadores distintos para comprobar que se pueden gestionar
dos sesiones diferentes a la vez
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ServletContext

m Cuando se despliega un proyecto, el contenedor web creara un
objeto ServietContext
= Hay uno por cada aplicacién web

m Tiene la informacion de configuracion del fichero web.xml

= Permite compartir informacién entre servlets de la aplicacién con el
elemento <context-param=>

m Puede servir para intercambiar informacién entre servlets y entre
aplicaciones

= Métodos
m Para tratar los parametros de inicializacion
e String getlnitParameter(String name)
e Enumeration<String> getlnitParameterNames()
e void setlnitParameter(String name, String value)
m Para crear, modificar y consultar atributos
* Object getAttribute(String name)
e Enumeration<String> getAttributeNames()

- void setAttribute(String name, Object object)
« Si object==null se elimina el atributo
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Ejercicios ServiletContext

m Listar todos los parametros de inicializacion
m Tiene que haber un fichero web.xml en WEB__INF
e Si no lo hubiera se puede crear en eclipse con
Java EE Tools &> Generate Deployment Descriptor Stub
e Se pueden afadir parametros de inicializacion con
<context-param>
<param-name>Autor</param-name>
<param-value>Juan Pavén</param-value>
</context-param>
m Se leeran desde el servlet como sigue:

ServletContext aplicacion=getServletContext();
Enumeration<String> e = aplicacion.getInitParameterNames();
String s="";
while (e.hasMoreElements()) {
s= e.nextElement();
out.print("</p>");
out.print(s+": "+aplicacion.getInitParameter(s));
out.println("</p>");

¥

Juan Pavon - UCM 2012-13 Servlets

30




Ventajas de los servlets respecto a CGls

m Los servlets se ejecutan como threads
= No requieren crear un proceso cada vez
= Se quedan en memoria, por lo cual no tienen que recargarse cada vez
= Una instancia puede gestionar multiples peticiones
m Por seguridad, se pueden ejecutar servlets en un sandbox

m  Arquitectura de aplicaciones web
m Java EE facilita la aplicacion de patrones de disefio
= Varios frameworks

m Acceso a todas las librerias Java existentes

= Portabilidad
= Cddigo Java

m Seguridad
m El cddigo Java se ejecuta en un contenedor
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